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Q1: What are the four fundamental parts of computer? Explain it with the help of diagram. 

Ans.   

Computer Block Diagram System: Mainly computer system consists of three parts, that 
are central processing unit (CPU), Input Devices, and Output Devices. The Central 
Processing Unit (CPU) is divided into two parts again: arithmetic logic unit (ALU) and the 
control unit (CU). The set of instruction is in the form of raw data. 
A large amount of data is stored in the computer memory with the help of primary and 
secondary storage devices. The CPU is like the heart/brain of the computer. The user does 
not get the desired output, without the necessary option taken by the CPU.  The Central 
processing unit (CPU) is responsible for the processing of all the instructions which are 
given by the user to the computer system. 

 

                                       Fig: Block Diagram of the computer. 
The data is entered through input devices such as the keyboard, mouse, etc. This set of 
instruction is processed by the CPU after getting the input by the user, and then the 
computer system produces the output. The computer can show the output with the help of 
output devices to the user, such as  monitor, printer, etc. 

 CPU (Central Processing Unit) 

 Storage Unit 

 ALU(Arithmetic Logic Unit) 

 Control Unit 

Central Processing Unit (CPU) 

https://www.tutorialandexample.com/input-devices-of-computer/
https://www.tutorialandexample.com/output-devices-of-computer/


The computer system is nothing without the Central processing Unit so, it is also known as 
the brain or heat of computer. The CPU is an electronic hardware device which can perform 
different types of operations such as arithmetic and logical operation. 

 

The CPU contains two parts: the arithmetic logic unit and control unit. We have discussed 
briefly the arithmetic unit, logical unit, and control unit which are given below: 

Control Unit 
The control unit (CU) controls all the activities or operations which are performed inside the 
computer system. It receives instructions or information directly from the main memory of 
the computer. 
When the control unit receives an instruction set or information, it converts the instruction 
set to control signals then; these signals are sent to the central processor for further 
processing. The control unit understands which operation to execute, accurately, and in 
which order. 

Arithmetic and Logical Unit 
The arithmetic and logical unit is the combinational digital electronic circuit that can perform 
arithmetic operations on integer binary numbers.It presents the arithmetic and logical 
operation. The outputs of ALU will change asynchronously in response to the input. The 
basic arithmetic and bitwise logic functions are supported by ALU. 

Storage Unit 
The information or set of guidelines are stored in the storage unit of the computer system. 
The storage unit provides the space to store the data or instruction of processed data. The 
information or data is saved or hold in computer memory or storage device. The data 
storage is the core function and fundamental of the computer components.   

Components of Computer System 
The hardware and software exist on the computer.  The information which is stored through 
the device is known as computer software. The hardware components of the computer 
system are related to electronic and mechanical parts, and the software component is 

https://en.wikipedia.org/wiki/Central_processing_unit


related to data and computer programs. Many elements are connected to the main circuit 
board of the computer system called a “motherboard.” 

 

 Processor. 

 Main Memory. 

 Secondary Memory. 

 Input Devices. 

 Output Devices. 
These are mainly five components of the computer system. The computer hardware, 
computer software, and liveware exist in the element of the computer system. 

Processor 
The processor is an electric circuitry within the computer system. The Central processing 
unit is the central processor or main processor of the computer system. The processor 
carries out the instructions of the computer program with the help of basic arithmetic and 
logic, input/output operations. 

Main Memory   
The Random Access Memory is the main memory of the computer system, which is known 
as RAM.  The main memory can store the operating system software, application software, 
and other information.  The Ram is one of the fastest memory, and it allows the data to be 
readable and writeable. 

Secondary memory 
 We can store the data and programs on a long-term basis in the secondary memory. The 
hard disks and the optical disks are the common secondary devices. It is slow and cheap 



memory as compare to primary memory. This memory is not connected to the processor 
directly. 
It has a large capacity to store the data. The hard disk has a capacity of 500 gigabytes. The 
data and programs on the hard disk are organized into files, and the file is the collection of 
data on the disk. The secondary storage is direct access by the CPU; that’s why it is 
different from the primary storage. 
The hard disk is about 100 times the capacity of the main memory. The main difference 
between primary and secondary storage is speed and capacity. There are several large 
blocks of data which are copied from the hard disk into the main memory. 

Input Devices 
The user provides the set of instruction or information to the computer system with the help 
of input devices such as the keyboard, mouse, scanner, etc. The data representation to the 
computer system is in the form of binary language after that the processor processes the 
converted data. The input unit implements the data which is instructed by the user to the 
system. 
We can enter the data from the outside world into the primary storage as the input through 
input devices. The input devices are the medium of communication between the outside 
world and the computer system. 
There are some important features of input devices which are given below: 

1. The input devices receive or accept the data or instruction from the user, who exist in the 

outside world. 

2. These devices convert the data or instruction into the machine-readable form for further 

processing. 

3. The input device performs like the connection between the outside world and our computer 

system. 

4. The keyboard and mouse are common examples of input devices. 

5. When the whole procedure is finished, we get the desired output from the output devices 

such as monitor, printer, etc. 

Output Devices 
The output devices produce or generate the desired result according to our input, such as a 
printer, monitor, etc. These devices convert the data into a human-readable form 
from binary code. 
The computer system is linked or connected to the outside world with the help of output 
devices. The primary examples of output devices are a printer, projector, etc. 
These devices have various features which are given below: 

1. These devices receive or accept the data in the binary form. 

2. The output devices convert the binary code into the human-readable form. 

3. These devices produce the converted result and show to the user. 

 

https://en.wikipedia.org/wiki/Binary_code


Q2: Discuss about the classification of computers based on size and 

capacity. 

Ans .   

Classification of Computer Based on Size and Capability 

  

Introduction 

Classification of computers are based on their architecture, speed of executing commands or 

instructions, peripheral used and also their uses. Microcomputers are usually used in home and 

offices and only a single user can perform the task using a microcomputer. Its storage and data 

handling capacity are limited as per the requirement for home and office work. The another type of 

computer is called minicomputer which has usually larger storage and can handle multiuser at a 

time. This chapter includes the classification of computers. 

  

Computer's Classification 

Computers are classified on different parameters, such as, storage capacity, processing speed and 

component (CPU) used in computers. Depending upon the components used and features of 

different computers, they are classified into four groups, Microcomputers, Minicomputers, Mainframe 

computers and Supercomputers. 

  

Micro Computers 

Micro Computer is a computer whose CPU (Central Processing Unit) is a microprocessor. All the 

components of a microprocessor are on a single integrated circuit chip. Micro computer can be 

categorized as the desktop, programmable and workstation. The microprocessor based computers 

are called third generation computers. They are the backbone of the modern computer era. The first 

and second generation computers are based on vacuum tubes and bipolar junction transistors. 

  



 

  

Desktop Computers 

Desktop computer is a type of microcomputer. A desktop computer has a keyboard for input data, a 

LCD or CRT monitor to display information and Central processing unit tower contains storage, 

memory, different types of drives, such as, CD drive, hard drive, etc. A desktop computer is mainly 

used at home and office applications. 

  

Programmable Computers (PDA) 

Personal digital assistance is a type of hand held programmable digital computer. It is used as 

notepads, address books and can connect to world web wave to share information. A PDA is 

equipped with mobile phone hence, called smallest computer. 

  

  

Workstation 

A workstation computer has greater memory capability and more extensive mathematical abilities. It 

is connected with other workstation computers or personal computer to exchange data and mostly 

used for scientific applications. It also supports multitasking applications. 

  

Mini Computers 

Minicomputers were introduced in early 1960s. They were faster than micro computers. Basically 

these computers were mainly multi-user systems, where many users work on the systems. Generally 



these types of computers had larger memories and greater storage capacity. They had large 

instruction set and address field. These kinds of computers have efficient storage for handling of 

text, in comparison to lower bit machines. Due to more efficient processor, speed and memory size, 

minicomputer was used in variety of applications and could support business applications along with 

the scientific applications. Minicomputer was a multi-user system which means more than one user 

could use this system simultaneously. 

  

Comparison of Micro and Mini computers 

  

Features Microcomputer Minicomputer 

Primary 
memory  

Shall memory Larger memory 

Word length  Small word 
length  

Larger word 
length 

Cost low Low High 

Processor Low High 

  

Mainframe Computers 

Mainframe computers are large and expensive machines. The word length of mainframe computers 

may be 48, 60 or 64 bits, memory capacity being in some megabytes and storage capacity in some 

terabytes. Generally they handle huge volumes of information and data. In terms of speed, they are 

having significant processing capacity. They are used in research organizations, large industries, 

airlines reservation where a large database has to be maintained. 

  

 

  

Super Computers 



Super Computers are the fastest computer in current era. The processing capabilities of super 

computer lies in the range of GIPS2, word length 64-128 or may be in 256 or so. The memory 

capacity of super computer is in some gigabytes or in terabytes. The storage capacity of this type of 

computer is in exabytes. 

  

 

  

The parallel processing of a super computer makes it very fast because it contains number of CPU 

that operates parallel. They are used at some research centers and government agencies involving 

sophisticated scientific and engineering tasks. 

  

Super computers are used for the followings: 

  

  Weapons research and development 

  Nuclear and plasma physics 

  Rocket research and development 

  Atomic research 



  Aerodynamics 

  

Units For Measuring Word Length, Data, And Storage Capacity of a Computer 

Computers are classified on the basis of their data processing speed better known as clock speed 

and the word length. The word length that is processed by a CUP at a time is one of the important 

feature of that CPU. 

  

The followings are the units for the measurement of data volume: 

  

bit bit 0 or 1 

Byte B 8 bite 

Kibibit Kibit 1024 bits 

kilobit Kbit 1000 bits 

kibibyte (binary) KiB 1024 bytes 

kilobyte (decimal) kB 1000 bytes 

megabit Mbit 1000 kilobits 

mebibyte (binary) MiB 1024 kibibytes 

megabyte (decimal) MB 1000 kilobytes 

gigabit Gbit 1000 megabits 

gibibyte (binary) Gibbs 1024 mebibytes 

gigabyte (decimal) GB 1000 megabytes 

terabit Tbit 1000 gigabits 

tebibyte (binary) TIB 1024 gibibytes 

terabyte (decimal) TB 1000 gigabyte 

Petabit Pbit 1000 terabyte  

pebibyte (binary) PiB 1024 tebibytes 

petabyte (decimal) PB 1000 terabytes 

exabit Ebit 1000 petabits 

exbibyte (binary) EiB 1024 pebibytes 

exabyte (decimal) EB 1000 petabytes 

 

Q3: What is the meaning of computer generation? 

How many Computer Generations are defined? 

What technologies were/are used?



Ans. Computer generations are based on when major 

technological changes in computers occurred, like the use of 

vacuum tubes, transistors, and the microprocessor. As of 

2020, there are five generations of the computer. 

Review each of the generations below for more 

information and examples of computers and technology 

that fall into each generation. 

 First generation (1940 - 1956) 

 Second generation (1956 - 1963) 

 Third generation (1964 - 1971) 

 Fourth generation (1972 - 2010) 

 Fifth generation (2010 to present) 

First generation (1940 - 1956) 

 

The first generation of computers used vacuum tubes as a 

major piece of technology. Vacuum tubes were widely 

used in computers from 1940 through 1956. Vacuum 

tubes were larger components and resulted in first 



generation computers being quite large in size, taking up 

a lot of space in a room. Some of the first generation 

computers took up an entire room. 

The ENIAC is a great example of a first generation 

computer. It consisted of nearly 20,000 vacuum tubes, 

10,000 capacitors, and 70,000 resistors. It weighed over 

30 tons and took up a lot of space, requiring a large room 

to house it. Other examples of first generation computers 

include the EDSAC, IBM 701, and Manchester Mark 1. 

Second generation (1956 - 1963) 

 

The second generation of computers saw the use 

of transistors instead of vacuum tubes. Transistors were 

widely used in computers from 6195 to 1963. Transistors 

were smaller than vacuum tubes and allowed computers 

to be smaller in size, faster in speed, and cheaper to 

build. 

The first computer to use transistors was the TX-0 and 

was introduced in 1956. Other computers that used 



transistors include the IBM 7070, Philco Transac S-1000, 

and RCA 501. 

Third generation (1964 - 1971) 

 

The third generation of computers introduced the use 

of IC (integrated circuits) in computers. Using IC's in 

computers helped reduce the size of computers even 

more compared to second-generation computers, and 

make them faster. 

Nearly all computers since the mid to late 1960s have 

utilized IC's. While the third generation is considered by 

many people to have spanned from 1964 to 1971, IC's 

are still used in computers today. Over 45 years later, 

today's computers have deep roots going back to the third 

generation. 



Fourth generation (1972 - 2010) 

 

The fourth generation of computers took advantage of 

the invention of the microprocessor, more commonly 

known as a CPU. Microprocessors, along with integrated 

circuits, helped make it possible for computers to fit 

easily on a desk and for the introduction of the laptop. 

Some of the earliest computers to use a microprocessor 

include the Altair 8800, IBM 5100, and Micral. Today's 

computers still use a microprocessor, despite the fourth 

generation being considered to have ended in 2010. 



Fifth generation (2010 to present) 

 

The fifth generation of computers is beginning to 

use AI (artificial intelligence), an exciting technology 

that has many potential applications around the world. 

Leaps have been made in AI technology and computers, 

but there is still room for much improvement. 

One of the more well-known examples of AI in 

computers is IBM's Watson, which was featured on the 

TV show Jeopardy as a contestant. Other better-known 

examples include Apple's Siri on the iPhone and 

Microsoft's Cortana on Windows 8 and Windows 10 

computers. The Google search engine also utilizes AI to 

process user searches. 

Additional information 
 When was the first computer invented? 

 Who is the father of the computer? 



 Computer history and timeline. 

 Computer history questions and answers. 

 See our generation definition for related links and information. 

 

 

 

Q4: Differentiate between Volatile & Non- Volatile memories. 

Ans. Volatile and Non-Volatile Memory are both types of computer memory. Volatile 

Memory is used to store computer programs and data that CPU needs in real time and 
is erased once computer is switched off. RAM and Cache memory are volatile memory. 
Where as Non-volatile memory is static and remains in the computer even if computer is 
switched off. ROM and HDD are non-volatile memory. 

Following are the important differences between Volatile and Non-Volatile Memory. 

Sr. 
No. 

Key Volatile Memory Non-Volatile Memory 

1 
Data 
Retention 

Data is present till power 
supply is present. 

Data remains even after power 
supply is not present. 

2 
Persistence Volatile memory data is not 

permanent. 
Non-volatile memory data is 
permanent. 

3 
Speed Volatile memory is faster than 

non-volatile memory. 
Non-volatile memory access is 
slower. 

4 
Example RAM is an example of Volatile 

Memory. 
ROM is an example of Non-Volatile 
Memory. 

5 
Data 
Transfer 

Data Transfer is easy in 
Volatile Memory. 

Data Transfer is difficult in Non-
Volatile Memory. 

6 CPU CPU can access data stored Data to be copied from Non-Volatile 
memory to Volatile memory so that 



Sr. 
No. 

Key Volatile Memory Non-Volatile Memory 

Access on Volatile memory. CPU can access its data. 

7 
Storage Volatile memory less storage 

capacity. 
Non-Volatile memory like HDD has 
very high storage capacity. 

8 
Impact Volatile memory such as 

RAM is high impact on 
system's performance. 

Non-volatile memory has no impact 
on system's performance. 

9 
Cost Volatile memory is costly per 

unit size. 
Non-volatile memory is cheap per 
unit size. 

 

Q5: Distinguish among system software, application software and 

open source software on the basis of their features.  

Ans. As we know that software is a set of instructions or programs instructing a 
computer to do specific tasks. Software is basically a generic term used to describe 
computer programs. In general Scripts, applications, programs and a set of instructions 
are all terms often used to describe software. 

Now the basis of language in which software is developed and platform which is 
required for its execution we can classified software as in two divisions which are 
System software and Application software. Following are some basic differences 
between System software and Application software. 

Sr. 
No. 

Key System Software. Application Software. 

1 

Definition System Software is the type of 
software which is the interface 
between application software 
and system. 

On other hand Application 
Software is the type of software 
which runs as per user request. 
It runs on the platform which is 
provide by system software. 



Sr. 
No. 

Key System Software. Application Software. 

2 

Development 
Language 

In general System software are 
developed in low level language 
which is more compatible with 
the system hardware in order to 
interact with. 

While in case of Application 
software high level language is 
used for their development as 
they are developed as some 
specific purpose software. 

3 
Usage System software is used for 

operating computer hardware. 
On other hand Application 
software is used by user to 
perform specific task. 

4 
Installation System software are installed on 

the computer when operating 
system is installed. 

On other hand Application 
software are installed according 
to user’s requirements. 

5 

User 
interaction 

As mentioned in above points 
system software are specific to 
system hardware so less or no 
user interaction available in 
case of system software. 

On other hand in application 
software user can interacts with 
it as user interface is available in 
this case. 

6 

Dependency System software can run 
independently. It provides 
platform for running application 
software. 

On other hand in application 
software can’t run independently. 
They can’t run without the 
presence of system software.. 

7 

Examples Some examples of system 
software’s are compiler, 
assembler, debugger, driver, 
etc. 

On other hand some examples 
of application software’s are 
word processor, web browser, 
media player, etc. 

Q6. a) Create a file in MS-word to insert a paragraph about yourself 

and save it with file name “yourself”. Describe all steps involved in it.  

 



Ans. 

Q6 b) Write steps regarding followings 

 

Ans.  

How to Change Font Style in MS Word 

The basic steps to change the font of a text in a document are given below; 

o Select the text you want to modify 

o Select the Home tab and locate the Font group 

o Click the drop-down arrow next to font style box 

o Font style menu appears 

o With a left click select the desired font style 

o If you want to change the font to bold or italic, click the 'B' or 'I' icons on the 

format bar. 

See the image: 

 



 

Ans. Change the size of selected text 

To change the font size of selected text in desktop 

Excel, PowerPoint, or Word: 

1. Select the text or cells with text you want to change. To 

select all text in a Word document, press Ctrl + A. 

2. On the Home tab, click the font size in the Font 

Size box. 

 

You can also type in any size you want, within the 

following limits: 

 Excel: between 1 and 409, between 1 and 409, in 

multiples of .5 (such as 10.5 or 105.5) 

 PowerPoint: between 1 and 3600, in multiples of .1 

(such as 10.3 or 105.7) 

 Word: between 1 and 1638, in multiples of .5 (such as 

10.5 or 105.5) 

Tips:  



 When you select text, a mini toolbar appears near your cursor. You can also change the text size in 

this toolbar. 

 
 You can also click the Increase Font Size or Decrease Font Size (Grow Font and Shrink Font in 

some earlier versions of Office programs) icons until the size you want is displayed in the Font 

Size box. 

 

  

Ans.  Change the font color 

Word for Microsoft 365 Word 2019 Word 2016 Word 2013 Word 

2010 Word 2007 

You can change the color of text in your Word 

document. 

1. Select the text that you want to change. 

2. On the Home tab, in the Font group, choose the arrow 

next to Font Color, and then select a color. 



 

You can also use the formatting options on the Mini 

toolbar to quickly format text. The Mini toolbar appears 

automatically when you select text. 

 

Q7. Create a file in MS-Word for the following document and save it 

with file name ‘ms_word’. Describe 

all steps involved in it. 

 Creating 

 Editing 

 Saving 

 Printing any type of document 



Ans. Creating a New Document 

When you start Word without opening an existing document, the 

program gives you an empty one to work in. If you’re eager to put 

words to page, then type away. Sooner or later, though, you’ll want to 

start another new document. Word gives you three ways to do so: 

 

Figure 1-1. When you start Word 2007 for the first time, it may look a little 

top-heavy. The ribbon takes up more real estate than the old menus and 

toolbars. This change may not matter if you have a nice big monitor. But if 

you want to reclaim some of that space, you can hide the ribbon by double-

clicking the active tab. Later, when you need to see the ribbon commands, 

just click a tab. 

Ans. Editing Tools 

This book covers: 
Formatting Text, Inserting Links, Edit and Remove links, Copy and 

paste from word, Add a table, Edit a table, HTML editor, Resize the 
edit window, and Additional editing toolbar functions 

Editing Tools 



 

The editing toolbar is displayed where content can be added or edited in 
course sites, and provides access to commonly used functions such as: 

 Format text. 

 Insert/edit an image. 

 Insert/edit a link. 

 Paste content. 

 Insert an emoticon. 

 View and edit HTML. 

 Page preview. 

Many of the editing toolbar icons look and function the same as the editing 

icons in Microsoft applications. Hovering your mouse over an icon will give 
you a description. 

Ans. From the earliest days of personal computing, the watchword 

has been “save early, save often.” There’s nothing more frustrating 

than working half the day and then having the Great American Novel 

evaporate into the digital ether because your power goes out. So, here 

are some tips to protect your work from disasters human-made and 

natural: 

 Name and save your document shortly after you first create it. 

You’ll see the steps to do so later in this section. 

 Get in the habit of doing a quick save with Alt+F, S 

(think File Save) when you pause to think or get up to go to the kitchen 

for a snack. (Note for old-timers: Ctrl+S still works for a quick save 

too.) 

 If you’re leaving your computer for an extended period of time, 

save and close your document with Alt+F, C (think File Close). 



UP TO SPEED: WHERE ARE MY KEYBOARD SHORTCUTS? 

Ribbons, buttons, and menus are all well and good when you’re doing something new or 

complicated. But when you know where you’re going, a good keyboard shortcut can save 

time. Word 2007 has dozens of keyboard shortcuts. If you don’t have your favorites 

memorized, use the Alt key to reveal them. 

Press the Alt key, and you see small badges with letters and numbers pop up next to 

menus and buttons. These are your shortcuts. If you’re looking for the keyboard shortcut to 

close your document, follow these steps: 

1. Press and release the Alt key to show the keyboard shortcut badges. 

When you do this, the badges appear over menu items and ribbon buttons. (The Alt key 

acts as a toggle. If you change your mind and don’t want to use a shortcut, then press the 

Alt key again and you’re back in normal typing mode.) 

2. Press F to open the Office menu. 

Pressing F (which used to stand for File menu) does the same thing as clicking the button 

with your mouse, except that now it sports little keyboard shortcut badges. 

3. Press C to close your document. 

Looking at the bottom of the Office menu, you see the Close command. A small C badge 

indicates that pressing C closes your document. 

As you can guess, most keyboard shortcuts are based on the initial letter of the actual 

command words. This doesn’t always work out for popular letters. As a result, you have 

cases like the References tab, which has the keyboard shortcut S. 

Even if you don’t deliberately work to memorize the keyboard shortcuts, you’ll find that you 

begin to learn your favorites as you use them. Before long, your fingers will tap them out 

automatically. 



If a substantial portion of your brain is occupied by keyboard shortcuts from previous 

versions of Word, never fear. Most of those old commands still work—including Ctrl+B 

for Bold, Ctrl+N for new document, and F7 for spell checking. 

The Many Ways to Save Documents 

It’s the Microsoft Way to give you multiple ways to do most everything. 

Whether that’s because the company’s programmers believe in giving 

you lots of choices, or because they can’t make up their minds about 

the best way to do something is a question best left to the 

philosophers. But the point is, you do have a choice. You don’t have to 

memorize every keystroke, button, and command. Especially 

with saving, the important thing is to find a way you like and stick with 

it. Here’s a list of some ways you can save the document you’re 

working on: 

Saving by keyboard shortcut 

 Ctrl+S. If you’re an old hand at Word, this keyboard shortcut 

may already be burned in your brain. It still works with Word and other 

Office programs. This command quickly saves the document and lets 

you get back to work. 

 Alt+F, S. This keyboard shortcut does the exact same thing as 

Ctrl+S. Unlike Ctrl+S, though, you get visual reminders of which keys 

to press when you press the Alt key. See the box above. 

Saving by menu command 

 Office button → Save. If you don’t want to use keyboard 

shortcuts, you can mouse your way to the same place using menus. 

Like the options above, this command saves your file with its current 

name. 

 Office button → Save As. The Save As option lets you save 

your file with a new name (Figure 1-17). When you use this command, 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-17


you create a new document with a new name that includes any 

changes you’ve made. (The individual steps are described in the next 

section.) 

 

 

Ans. Printing Documents 

The following steps will help you print your Microsoft Word document. 

Step 1 − Open the document for which you want to see the preview. Next click 
the File tab followed by the Print option which will display a preview of the document in 
the right column. You can scroll up or scroll down your document to walk through the 
document using given Scrollbar. The middle column gives various options to be set 
before you send your document to the printer. 



 

Step 2 − You can set various other printing options available. Select from among the 
following options, depending on your preferences. 



 

S.No Option and Description 

1 
Copies 

Set the number of copies to be printed; by default, you will have one copy of the 
document. 

2 

Print Custom Range 

This option will be used to print a particular page of the document. Type the 
number in Pages option, if you want to print all the pages from 7 till 10 then you 
would have to specify this option as 7-10 and Word will print only 7th, 8th, 9th and 
10th pages. 

3 Print One Sided 

By default, you print one side of the page. There is one more option where you will 



turn up your page manually in case you want to print your page on both sides of 
the page. 

4 
Collated 

By default, multiple copies will print Collated; if you are printing multiple copies and 
you want the copies uncollated, select the Uncollated option. 

5 
Orientation 

By default, page orientation is set to Portrait; if you are printing your document in 
landscape mode then select the Landscape mode. 

6 
A4 

By default, the page size is A4, but you can select other page sizes available in the 
dropdown list. 

7 

Custom Margin 

Click the Custom Margins dropdown list to choose the document margins you 
want to use. For instance, if you want to print fewer pages, you can create 
narrower margins; to print with more white space, create wider margins. 

8 

1 Page Per Sheet 

By default, the number of pages per sheet is 1 but you can print multiple pages on 
a single sheet. Select any option you like from the given dropdown list by clicking 
over the 1 Page Per Sheet option. 

Step 3 − Once you are done with your setting, click on the Print button which will send 
your document to the printer for final printing. 

  



Q8. Create a file in MS-word for the following document and save it 

with file name ‘equations’. Describe 

all steps involved in it. 

Ans. Microsoft (MS) Word 2007 has a built-in equation editor which is now the default 
when you create equations. The equation editor is only available in Word 2007 and not 
Excel, Powerpoint or other applications. 

Microsoft Equation 3.0, the default equation editor in previous versions, is still available 
and can also be used in Excel, PowerPoint, or any application that supports Object 
Linking and Embedding (OLE). See the course notes on using Microsoft Word '97 for 
the old equation editor for more information. 

Comparison of options for equation editing 

Feature Office 2007 built-in 

equation editor 
Microsoft Equation 3.0 

(old version) 

Ease of use Very intuitive, "builds-up" 

equations as you type 
Not as intuitive, steeper 
learning curve 

Keyboard 

shortcuts 
Standard math and LaTeX 
symbols work 

Custom (e.g., Ctrl-H for 

superscript) 

Display 

equations 
Display equations can't be on 

the same line as other text 
Able to use tabs on same 

line as display equations 

Equation 

numbering 
Need to use tables to create 
equation numbers 

Adding equation 
numbers is simpler 

Rendering Very high quality Moderate quality 

Interoperability Not accepted by some 

journals, no workarounds! 
Commonly used and 

interoperable 

When not to use the Office 2007 equation editor 

When you convert a document that includes Office 2007 equations to the old ".doc" 
format, the equations are turned into graphics. They are visible, but not editable. We 
recommend that you do not use the Office 2007 Equation Editor if: 

 You need to submit to a journal that does not accept Office 2007 .docx files 
 You need to collaborate with people who do not have Office 2007 
 You use Office 2007 in Compatibility Mode (.doc files) 

https://uwaterloo.ca/information-systems-technology/services/scientific-computing-software-support/supported-software-scientific-computing/creating-numbering-and-cross-referencing-equations-microsoft


In these situations, the recipients of your documents will not be able to edit the 
equations. This would make collaboration difficult, and in the case of journals, would 
make submission problematic and revision impossible. 

Why use the Office 2007 equation editor 

Word 2007's method of entering equations from the keyboard and building up 
equations is more natural, intuitive and efficient than earlier approaches to typesetting 
equations. Word's internal representation of the equations resembles mathematics, and 
is much more readable. 

By comparison the MS Equation Editor approach takes a visual rather than 
mathematical approach. A markup language like LaTeX remains the best choice for 
complicated documents and for overall typesetting quality, yet the source code for an 
equation in LaTeX rarely looks like math. 

How Office 2007's equation editor "builds-up" equations 

The new Office 2007 equation editor works in a different way than the old equation 
editor. It uses the AutoCorrect feature of MS Word to do some of the formatting, and it 
introduces a concept of "Linear" vs. "Professional" formats. Linear format is what you 
might use in a programming language to write mathematics: e.g., y = (a*x+b)/(x^2+1). 

As you type an equation, Word converts it on the fly (Microsoft calls this "building up") 
into professional format. In order to use the equation editor efficiently, you will need to 
get used to how Word builds up equations. A good way to learn is to carefully watch 
what happens on screen as you push each key. 

Some symbols are inserted automatically by Word as you type using AutoCorrect. And 
some formatting is applied as you type. The rule is that the equation is built up when 
you type any character than makes what you've typed so far unambigious. As a result, 
AutoCorrect and building up are only triggered by certain keys. The spacebar always 
builds up and triggers autocorrect, and using it is a good way to force Word 2007 to 
interpret what you've typed so far. 

Learning how to use the equation editor 

To insert an equation in a Word 2007 document, click on the "Insert" menu/tab to see 
the "Insert" ribbon. In the "Symbols" section, choose "Equation". You can also press 
"Alt+=" on your keyboard. 



 

 

You will now see Equation Tools | Design Ribbon. There are three main sections. 

Tools 

 

In the "Tools" section you have access to the "Equation" gallery, and you can select 
"Professional", "Linear" or "Normal Text" modes. Professional format is rendered two-
dimensional math, as you would write on paper or a blackboard. Linear format is the 
equation editor's internal format. Normal text is for non-mathematical text annotations 
within an equation. 

Professional format:  

Linear format:  

Notice that linear format has redundant brackets to make the mathematical 
interpretation unambiguous. When the equation is formatted, Word automatically 
removes these brackets. The square root symbol is a single character, and its operand is 
the bracketed expression immediately following the square root character. You can force 
Word to show an expression in brackets by using two sets of brackets around the 
expression. 

Symbols 



 

The symbols section contains commonly-used mathematical symbols. You can use the 

two scroll buttons to see more, or click the  icon to view all of the "Basic Math" 
symbols. Then click on "Basic Math" to see other sections of symbols: 

1. Basic math 
2. Greek letters 
3. Letter-like symbols 
4. Operators 
5. Arrows 
6. Negated relations 
7. Scripts 
8. Geometry 

Exercise 

Insert an equation, explore the symbol palettes and find symbols that you will need in 
your manuscripts. 

Structures 

 

The "Structures" section contains the formatting tools you will use to create equations. 
Each section contains 'structures' which are like a template with one or more symbols, 
and one or more placeholders for you to place your mathematical content into. 

For example, to create a fraction, choose "Fraction" then the first template. You will see 
a fraction where the numerator and denominator are both boxes with dotted lines. You 
will place your content in the place of these boxes. 

The "Matrix" structures are not only useful for true matrices and arrays, but can also be 
used to align certain types of equations and to place notes in and around equations. 

Examples of structures 



The integral menu contains indefinite, definite, double and triple integrals. There will be 
a placeholder for the integrand. Definite integrals also include placeholders for the 
upper and lower limits of integration. 

 

More complicated expressions can be constructed by having structures inside of other 
structures, for example: 

 

The right hand side of the above equations consists of a "Bracket" structure. Inside the 
bracket's placeholder is a 3x2 matrix. In order for this to look right, the matrix has been 
modified for left alignment of the second column, and the word "if" has been changed to 
"Normal text". 

Keyboard entry of equations 

Standard characters that are on your keyboard you will type directly into the equation 
editor. The equation editor also recognizes many conventions for typing math: 

Keyboard Result 

^ Superscript 

_ Subscript 

/ Fraction 

() {} [] Standard brackets 

<, > Inequalities 

<=, >= Converted to standard less/greater than or equal to 

In addition, there are a number of symbols that can be entered by typing backslash "\" 
and the name of the character. (These are mainly based on LaTeX codes.) 

Keyboard Description Example 



\alpha \beta \gamma \delta Greek Letters Αβγδ 

\Alpha \Beta \Gamma \Delta Uppercase Greek Letters ΑΒΓΓ 

\pm or +- Plus/Minus symbol ± 

\sqrt(x) \sqrt(n&x) Square root, nth root 
√,  

\le or <= Less than or equal to ≤ 

\sum \prod Sum, product ∑, ∏ 

\int Integration symbol ∫ 

\times Multiplication x 

\ominus \oplus \otimes Operators in circles ⊖⊕⊗ 

\equiv Congruent symbol ≡ 

\approx Approximately equal to ≈ 

\in Element of set ∈ 

As you type, the equation editor converts recognized symbols to the corresponding 
graphical characters. This conversion happens as soon as you've typed enough to make 
the math unambiguous. You can trigger an update by pressing the space bar. You can 
also choose "Professional" format to force the equation editor to render and interpret 
what you've typed so far. 

Putting an equation button on the tool bar 

If you are entering many equations, you may find it convenient to have an "Insert 
Equation" button right on the "Quick Access Toolbar". 

1. Click on the arrow to the right of the "Quick Access Toolbar" 

 

2. Choose "More Commands..." 
3. Under "Choose commands from", select "Insert Tab", choose "Equation" from the list 

and click "Add" 



 

4. Click "OK". 

Moving around the equation 

The cursor indicates where you are about to enter information on the equation. The 
equation editor highlights the region of the formula in which you are working, e.g. the 
placeholder of a bracket, a superscript, a numerator/denominator of a fraction. You can 
set the insertion point by clicking with the mouse, or with the keyboard. You can use the 
left arrow and right arrow keys to move through the equation. For more advanced 
editing, can you change the equation to "Linear Mode", make corrections, then switch 
back to "Professional Mode". 

Exercise 

Enter the equation: 

 

Method 1 

Start the equation editor (Insert | Symbols | Equation or ALT+=) and: 

1. Type "x=" from the keyboard 
2. Choose a fraction from Structures | Fraction 



3. Click on the numerator, type -b from the keyboard 
4. Select "plus or minus" from the Symbols ribbon 
5. Select a radical from Structures | Radical 
6. Click in the placeholder 
7. Type b from the keyboard 
8. Select "b" 
9. Select a superscript from the Script palette 
10. Select the superscript, Type "2" from the keyboard 
11. Press the right arrow to come down a level, and type "-4ac" 
12. Click the denominator (or press the right arrow twice) Type 2a 

Method 2: Keyboard entry 

Tip: You can use extra brackets to show Word how to interpret what you type. 

Type "x=(-b+-\sqrt(b^2-4ac))/2a" 

Notice: 

1. When you type the second "\" Word replaces +- with the plus or minus symbol. You 
could also type \pm. 

2. When you type the second "(" Word replace \sqrt with the square root symbol. 
3. When you type "-4ac" Word turns "^2" into a superscript. 
4. When you type the SECOND ")" Word expands the square root. 
5. Word automatically hides redundant parentheses, we entered these to show Word how 

to format the equation. 
6. Word puts "2a" in the denominator even though this is ambiguous the way we typed it. 

Method 3: "Cheating" 

Click on the Equation button, and you will find that the quadratic formula is available as 
a Building Block in the Equation Gallery. You can save your own equations to the 
Equation Gallery so that you will only have to typeset them once. 

Deleting from equations 

As you are entering the equation, you can backspace at any time. You can also select 
parts of the equation with the mouse, and delete. 

Growing brackets 

Brackets, parentheses and braces will automatically grow with the enclosed text. You 
can toggle this behave by right-clicking in the placeholder section of a bracket, and 
choose "Stretch Brackets". 

Exercise: Typeset a continued fraction 



 

(To enter the above continued fraction from the keyboard, you can type: 
"1/(2+3/(4+5/(6+7/(8+9/10))))" then press the spacebar to format the final fraction.) 

Matrices 

Matrices of any size can be created from the Matrix section of the Structures ribbon. 
Once you have inserted a Matrix, you will be able to right click on it to add or delete 
columns and rows. You can also change the alignment settings for the rows and 
columns. 

Exercise: Typeset a 4x4 matrix in square brackets 

There is a built-in option for a matrix surrounded by square brackets. It is also possible 
to add the square brackets to an existing matrix. 

 

Exercise: Format the matrix 

Once you've created a matrix, you can right-click inside it to access spacing settings. 
These allow you to adjust the overall positioning of the matrix and the row and column 
spacing. You can also access settings for alignment of rows and columns. 

Aligning at the equal sign character 

When you are typing a derivation, you may want to show a calculation with your equals 
signs lining up. Compare Word's default of centering: 



 

to the more standard view: 

 

Exercise: Typeset a calculation aligned at the equals sign 

1. Create an equation (Insert | Equation) or Alt+= 
2. Type y=(x-1)(x+1)(x^2+1) 
3. Press Shift-Enter (this tells Word to create a new line, but to group it with the current 

equation) 
4. Type y=(x^2-1)(x^2+1) 
5. Press Shift+Enter 
6. Type =(x^4-1) 
7. Your equations are now being centered as a group, but they are aligned on the left 
8. Select the equals sign (=) in each equation, right click and choose "Align at this 

character" 

Aligning a set of equations 

In system of several variables, you may have several equations in the same variables and 
want the coefficients lined up: 

 

At this time, there is no way to create an equation array from the menu interface. You 
would not want to use a matrix for this type of alignment, because it would be difficult to 
get the spacing right. In addition, an equation array automatically aligns at the equals 
signs. Here is how to create an equation array using the keyboard: 

1. Create an equation (Insert | Equation) or ALT+= 
2. Type \eqarray 
3. Type (2&x + &3&y + &&z = &10& @ 
4. Type 4&x + &&y -&&z = &3& @ 
5. Type &x + &10&y+&&z = &25&) 



6. Press spacebar 

Q9. Create a file in MS-word that convert existing highlight text to 

table as shown below and save it as file name ‘text_to_table’. 

Describe all steps involved in it. 

Ans. Convert text to a 

table or a table to 

text 
Word for Microsoft 365 Outlook for Microsoft 365 Word 

2019 Outlook 2019 More... 

To convert text to a table or a table to text, start by 

clicking the Show/Hide paragraph mark on 

the Home tab so you can see how text is separated in 

your document. 

javascript:


 

Convert text to a table 

1. Insert separator characters—such as commas or tabs—

to indicate where to divide the text into table columns. 

2. Use paragraph marks to indicate where you want to 

begin a new table row. 

In this example, the tabs and paragraph marks will 

produce a table with 3 columns and 2 rows: 

 

3. Select the text that you want to convert, and then 

click Insert > Table > Convert Text to Table. 



 

4. In the Convert Text to Table box, choose the options 

you want. 

 

Under Table size, make sure the numbers match the 

numbers of columns and rows you want. 



Under AutoFit behavior, choose how you want your 

table to look. Word automatically chooses a width for 

the table columns. If you want a different column width, 

choose one of these options: 

To do this Choose this option 

Specify a width for all the columns In the Fixed column 

width box, type or select a 

value. 

Resize the columns to fit the width of the text in each column AutoFit to contents 

Resize the table automatically in case the width of the available 

space changes (for example, web layout or landscape orientation) 

AutoFit to window 

Under Separate text at, choose the separator character 

you used in the text. 

5. Click OK. The text converted to a table should look 

something like this: 

 

Convert a table to text 

1. Select the rows or table you want to convert to text. 



2. On the Layout tab, in the Data section, click Convert 

to Text. 

 

3. In the Convert to Text box, under Separate text with, 

click the separator character you want to use in place of 

the column boundaries. Rows will be separated by 

paragraph marks. 

4. Click OK. 

Q10. Create a file in MS-Word to insert a table in the document. 

Describe all steps involved in it. 

Ans. The basic steps for creating a standard table in Microsoft Word (2013) are: 

1. Open a blank Word document 

2. In the top ribbon, press Insert 

 

3. Click on the Table button 

 

4. Either use the diagram to select the number of columns and rows you need, or click Insert 
Table and a dialog box will appear where you can specify the number of columns and rows. 



 

5. The blank table will now appear on the page. Alter it as necessary. Standard features 
like bold, italics, and underline are still available! These items may be helpful for creating headings 
or calling out certain items in the table. 

6. Follow these instructions for ensuring your table meets APA formatting guidelines. 

 

Need additional help? The tutoring service has self-paced table and chart lessons/tutorials within 
SkillSurfer. Follow these steps to access: 

1. Log into the tutoring service (click on the blue hyperlink to the left to login!) 

2. Click on SkillSurfer 

3. Click on Computers and Technology 

4. Click on Intermediate underneath Microsoft Word 

5. Select Creating Tables and Charts 

6. Choose the exact item(s) you wish to learn about (likely Creating Tables from Scratch). 



 

 

Q11. Create a following worksheet in MS-excel and save it with name 

‘book1’. 

Ans.  

 

 

 

 

 

 

 

 

 

 

Q12. Calculate the following things of a range (C2:C11) of data in the 

worksheet created in question no 10. 

Ans.   



1.  the sum of the marks using AutoSum in a range of cells 

(C2:C11) 

ou can use a simple formula to sum numbers in a range (a 

group of cells), but the SUM function is easier to use when 

you’re working with more than a few numbers. For 

example =SUM(A2:A6) is less likely to have typing errors 

than =A2+A3+A4+A5+A6. 

 

Here’s a formula that uses two cell 

ranges: =SUM(A2:A4,C2:C3) sums the numbers in ranges 

A2:A4 and C2:C3. You’d press Enter to get the total of 

39787. 

To create the formula: 

1. Type =SUM in a cell, followed by an opening 

parenthesis (. 

2. To enter the first formula range, which is called 

an argument (a piece of data the formula needs to run), 

type A2:A4 (or select cell A2 and drag through cell A6). 

https://support.microsoft.com/en-us/office/use-excel-as-your-calculator-a1abc057-ed11-443a-a635-68216555ad0a
https://support.microsoft.com/en-us/office/sum-function-043e1c7d-7726-4e80-8f32-07b23e057f89


3. Type a comma (,) to separate the first argument from the 

next. 

4. Type the second argument, C2:C3 (or drag to select the 

cells). 

5. Type a closing parenthesis ), and then press Enter. 

Each argument can be a range, a number, or single cell 

references, all separated by commas. 

 =SUM(A2:A4,2429,10482) 

 =SUM(4823,A3:A4,C2:C3) 

 =SUM(4823,12335,9718,C2:C3) 

 =SUM(A2,A3,A4,2429,10482) 

 2. average of the marks in a range of cells (C2:C11) 

Returns the average (arithmetic mean) of the arguments. For 

example, if 

the range A1:A20 contains numbers, the 

formula =AVERAGE(A1:A20) returns the average of those numbers 

3. highest marks in a range of cells (C2:C11) 

MAX will return the largest value in a given list of arguments. From a 

given 

set of numeric values, it will return the highest value. Unlike MAXA 

function, 

the MAX function will count numbers but ignore empty cells, text, the 

logical 



values TRUE and FALSE, and text values. 

=MAX(number1, *number2+, …) 

4. minimum marks in a range of cells (C2:C11) 

The Microsoft Excel MIN function returns the smallest value from the 

numbers provided. 

=MIN(A2, A3) 

 

Q13 a) Describe various steps involved 

Ans. If you find yourself needing to expand or reduce 

Excel's row widths and column heights, there are 

several ways to adjust them. The table below shows the 

minimum, maximum and default sizes for each based 

on a point scale. 

Notes:  

 If you are working in Page Layout view (View tab, Workbook Views group, Page Layout button), 

you can specify a column width or row height in inches, centimeters and millimeters. The 

measurement unit is in inches by default. Go to File > Options > Advanced > Display > select an 

option from the Ruler Units list. If you switch to Normal view, then column widths and row heights 

will be displayed in points. 

Type Min Max Default 

Column 0 (hidden) 255 8.43 

Row 0 (hidden) 409 15.00 



 Individual rows and columns can only have one setting. For example, a single column can have a 25 

point width, but it can't be 25 points wide for one row, and 10 points for another. 

Newer versionsOffice 2007 – 2010 

Set a column to a specific width 

1. Select the column or columns that you want to change. 

2. On the Home tab, in the Cells group, click Format. 

 

3. Under Cell Size, click Column Width. 

4. In the Column width box, type the value that you want. 

5. Click OK. 

b.To modify the row height of a worksheet 

Ans. To modify row height: 

1. Position the cursor over the row line so the white cross becomes 

a double arrow . 
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2. Click and drag the row downward to increase row height or 

upward to decrease height. 

 

3. Release the mouse. The height of each selected row will be 

changed in your worksheet. 

 

c. To delete rows and columns of a worksheet 

Ans. Deleting columns and rows 

Columns and rows are deleted in much the same manner as 

inserting columns and rows. 

To delete a row and all information in it: 

 Select a cell in the row to be deleted. 

 Choose Edit Delete from the menu bar. 



 Click Entire Row in the Delete dialog box. 

 

 

 Click OK. 

To delete a column and all information in it: 

 Select a cell in the column to be deleted. 

 Choose Edit Delete from the menu bar. 



 Click Entire Column in the Delete dialog box. 

 

 

Q13 b) Describe following terms in the worksheet 

a. Absolute reference and relative reference in formula 

AnS. To create and copy a formula using relative 

references: 

In the following example, we want to create a formula that will 

multiply each item's price by the quantity. Rather than create a 

new formula for each row, we can create a single formula in 

cell D2 and then copy it to the other rows. We'll use relative 

references so the formula correctly calculates the total for each 

item. 

1. Select the cell that will contain the formula. In our example, we'll 

select cell D2. 



 

2. Enter the formula to calculate the desired value. In our example, 

we'll type =B2*C2. 



 
Press Enter on your keyboard. The formula will be calculated, and the result will be displayed in the cell. 

3. Locate the fill handle in the lower-right corner of the desired cell. 

In our example, we'll locate the fill handle for cell D2. 



 

4. Click, hold, and drag the fill handle over the cells you wish to fill. 

In our example, we'll select cells D3:D12. 



 

5. Release the mouse. The formula will be copied to the selected cells 

with relative references and the values will be calculated in each 

cell. 



 

You can double-click the filled cells to check their formulas for 

accuracy. The relative cell references should be different for each 

cell, depending on its row. 



 

b. Cell address 

Ans. A cell reference, or cell address, is an alphanumeric value used to identify a specific cell 

in a spreadsheet. Each cell address contains “one or more letters” followed by a number. The 

letter or letters identify the column and the number represents the row. 

Q14. a) What tools are available to customize our PowerPoint 

presentation? 

Ans. PowerPoint is a very practical presentation tool. But no matter how many 

times you have worked with PowerPoint before, there are a few tips and tricks 

that can help customize your presentation. The first part of this article will explain 

how to customize presentation options and views and in the second part we will 

show you how to navigate by using presentation views. Please read on.. 



Customize presentation options and views 

Changing page setup options 

Presentations are created mainly to project either on a projector or more and more 

frequently to a plasma or TV screen. There are times when a presentation can be 

created for delivery in different formats. 

·         On-screen show (4:3) 

·         Letter Paper (8.5 x 11 in) 

·         Ledger Paper (11 x 17 in) 

·         A3 Paper (297 x 420 mm) 

·         A4 Paper (210 x 297 mm) 

·         B4 (ISO) Paper (250 x 353 mm) 

·         B5 (ISO) Paper (176 x 250 mm) 

·         35mm Slides 

·         Overhead 

·         Banner 

·         On-screen Show (16:9) 

·         On-screen Show (16:10) 

·         Widescreen 

·         Custom 

  

To select a slide size other than the standard one: 

1. In Slide Master View 
2. Click on Slide Size 
3. Select from one of the two options 
4. For more choices, click Custom 
5. Select one of the options 

http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view11.png


 

Figure 89- standard or widescreen 

 

Figure 90 – other options 

If you change the orientation to Portrait for 

the presentation it will apply to all the 

slides. 

Changing to view in color/grayscale 

Why change to view the presentation in grayscale? You might want to print the 

presentation and to print in colour is more expensive than printing to greyscale, so you 

need to see what the presentation looks like in grayscale before you print. 

 

Figure 91- colour/grayscale options 

On the View Ribbon, click on the option you want, Colour, Grayscale or Black and 

White. 

Then from the Grayscale Ribbon select the option you want to see: 

http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view1.png
http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view2.png
http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view3.png


 

Figure 92- grayscale options 

To get back to the colour view, click Back to Colour View. 

Navigating using presentation views 

There are several different views in PowerPoint as we saw earlier and you can navigate 

through the presentation in each in different ways. 

In Normal View 

 Click on the thumbnail of the slide you want to see 

 Use the Vertical Scrollbar to move between slides 

 Use the up and down arrow keys on the keyboard to move one slide backwards or forwards 

In Slide Sorter View 

 Click on the slide you want to select 

 Use the arrow keys to move up, down, left and right 

In Reading View 

Use the next and back icons in the status bar to move back or forwards or use the menu 

which is accessed from the icon in the middle 

http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view4.png


 

Figure 93- reading view 

Pick from the menu – you can use Go to Slide to pick 

the slide number 

 

Figure 94 – icons 

Back and Next icons move between slides. 

  

In Slide Show view 

When presenting you can use the mouse or the arrows on the keyboard to move 

through the presentation one slide at a time. 

You can also type the number of the slide you want to see and press Enter. 

When you hover the mouse over the bottom left corner of the slide on display you will 

notice some faint icons, there is a back arrow and forward arrow which move you 

through one slide at a time. 

 

http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view5.png
http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view6.png
http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view7.png


Figure 95- slide show icons 

Use the fourth icon along to show the slides in a presentation view of Slide Sorter View. 

This lays the slides on the screen and you can click on the one you want to see 

 

Figure 96- Slide Sorter in presentation view 

Use the back arrow at the top left to get back to the slide you started from. 

To end the slide show, press the Escape Key on the keyboard – this takes you back to 

PowerPoint in the edit mode which means that your audience will see the back end of 

your presentation. 

You can also use the End Presentation option which is on the small ellipse icon on the 

bottom left of the slide when you hover the mouse 

http://bookboon.com/blog/wp-content/uploads/sites/5/2015/09/view8.png


Q14 b) Write the steps for the following action for creation of power 

point presentation 

 

A . Open a Blank presentation 

Ans.  
 

 

 

Click the Other Task Panes button and click New Presentation. 

 

Click the Blank Presentation link in the New Presentation pane. 

 

PowerPoint immediately starts a new presentation with a single slide and a 

default layout. The Slide Layout pane also opens. 



INTRODUCTION 

When you create a blank presentation, PowerPoint starts with a single slide and a plain 

white background. You can add a background, graphics, and other objects to the slide 

later. You can use the Slide Layout pane to assign a layout for the slide. A layout is 

simply the arrangement of slide objects. 

TIP 

Other Ways to Start a Blank Presentation 

You can also click the New button on the Standard toolbar, or select File, New to 

create a blank presentation. Alternatively, you can click the Blank Presentation link on 

the New Presentation pane. 

TIP 

Where Is My Task Pane? 

If you closed your Task pane, you must open it again to click the Blank Presentation 

option. See Part 1, "Getting Started with PowerPoint," to learn how to display and hide 

the Task pane and how to view different panes in the Task pane. 

 



 

Use the scroll arrows on the right side of the pane to scroll through the Slide 

Layout pane to view layouts. When you find a layout you like, click it. 

 

PowerPoint changes the blank slide's layout. 

TIP 

Adding Text 

You can click placeholder text and start typing your own text for the slide. To learn 

more about adding text, see the task "Replacing Placeholder Text" later in this part. 

TIP 

Do I Have to Choose a Layout? 

If you prefer to design your own layout from scratch, you can select the Blank layout, 

located in the Content Layout section of the Slide Layout pane, and add your own text 

boxes and other slide objects later. 

b. Save the presentation as Lab1.pptx 

ANS.  

One of the most basic tasks in PowerPoint is being able to save your work; this is 
probably the most important task as well. There are many users who have burnt their 
fingers for not saving their work in time and losing hours of hard work. The following 
are the basic steps to save a presentation. 

Step 1 − Click on the File tab to launch the Backstage view and select Save. 



 

Step 2 − In the Save As dialog, type in the file name and click "Save". 

 

Step 3 − The default file format is .pptx. If you want to save the file with a different 
name, choose one of the file types from the "Save as type" dropdown list. 



 

If you are working on an already saved file, the "Save" option in the Backstage view 
will directly save the file in the existing format with the existing name. If you want to 
change the format or filename of an existing file, use the Save As option instead. 

 



 

C. Add a Title to the first slide: the name of your college 

Ans. 1. Open a Blank presentation 

2. Save the presentation as PowerPointLabOne.pptx 

3. Add a Title to the first slide: the name of your college 

4. Type your first name and last name in the Subtitle section 

5. Add a New Slide which has a Title and Content 

6. Add a title to the second slide “My Future Goals” 

7. In the Content section of the second slide, add at least three Personal Goals 

8. Right click on the second slide from the left panel, then choose Duplicate Slide 

9. Highlight the text in the Content area of the third slide. Under the Home tab, 

click Convert to SmartArt, then choose Basic Cycle 

10. Change the SmartArt Colors to Colorful—Accent Colors 

11. Change the SmartArt Styles to 3D Polished 

12. From the left panel, drag the third slide between the first and second slide 

13. Change the layout of the third slide, the slide that does not have the SmartArt, 

to Comparison 

14. Leave the title “My Future Goals” 

15. In the head of the first column, type “Goals in College,” then center the 

heading 

16. In the head of the second column, type “Goals after College,” then center the 

heading 



 

17. Add at least three goals in each section 

18. Make sure that slide #3 is selected from the left panel, then add a New Slide 

19. Change the layout of the new slide to Blank 

20. Insert a Graduation Online Picture from the Office ClipArt—Choose any image 

of your 

choice 

21. Change the ClipArt size to 3” X 3” and position it in the middle of the slide 

22. Apply the Wisp Design Theme 

23. Save and upload PowerPointLabOne.pptx to your instructor 

 

5. Add a New Slide which has a Title and 

Content 

Ans.  

. Insert a New Slide in PowerPoint: Overview 
            In this tutorial, you will learn how to insert a new slide in PowerPoint. When you create a 
new presentation, PowerPoint gives you one default slide that contains a “Title Slide” layout. 
You can click into the placeholders shown in the title slide. Then type the text you want to 
appear as the title and subtitle of your presentation. 

            To add another presentation slide, you must then insert a new slide and determine 
which placeholders appear in it. The slide layout you apply determines which placeholders 
appear within the new slide. However, you can also change the slide layout to change the 
placeholders after it is applied. 

            To insert a new slide in PowerPoint with a “Title and Content” slide layout, click the 
“Home” tab in the Ribbon. Then click the “New Slide” button in the “Slides” button group. 



            To insert a new slide in PowerPoint with a different slide layout, click the drop-down  

 

 

 

 

 

 

 

 

 

 

Q15. Write steps for creation of a set of PowerPoint slides that demonstrates 

your skill to usethe tools of PowerPoint. It should include the following things 

A) Title slide &bullet list 

Ans.   

Title a slide 

There are multiple way to add titles to your slides in PowerPoint. Use 

the Layout option to create a standalone title slide or to add a title to a slide 

that contains other text. You can also use the Outline view to create and update 

the titles of your slides 

Show each bullet point with a click 

1. Select the text box that contains the slides you want to 

animate. 



 

2. Click the Animations tab, and then choose a motion 

effect like Appear or Fly In. 

 

3. The slide displays the animation sequence in a box to 

the left of each point. 

 



Show each bullet point after a delay 

1. Select all the bullet points you want to animate, click 

the Animations tab, and then choose a motion effect 

like Appear or Dissolve In. 

 

2. In the Animations pane, select the second animation in the list. 

 

3. Under Timing, change the Start setting to After Previous, and then 
enter the amount of time you want to delay between each bullet point. 

 



 

B) Inserting Excel Sheet 

Ans. Insert an object in your Excel spreadsheet 

You can use Object Linking and Embedding (OLE) to 

include content from other programs, such as Word or 

Excel. 

OLE is supported by many different programs, and OLE 

is used to make content that is created in one program 

available in another program. For example, you can 

insert an Office Word document in an Office Excel 

workbook. To see what types of content that you can 

insert, click Object in the Text group on the Insert tab. 

Only programs that are installed on your computer and 

that support OLE objects appear in the Object 

type box. 

Embed an object in a worksheet 

1. Click inside the cell of the spreadsheet where you want 

to insert the object. 



2. On the Insert tab, in the Text group, click Object  . 

 
3. In the Object dialog box, click the Create from 

File tab. 

4. Click Browse, and select the file you want to insert. 

5. If you want to insert an icon into the spreadsheet 

instead of show the contents of the file, select 

the Display as icon check box. If you don’t select any 

check boxes, Excel shows the first page of the file. In 

both cases, the complete file opens with a double click. 

Click OK. 

Insert a link to a file 



You might want to just add a link to the object rather 

than fully embedding it. You can do that if your 

workbook and the object you want to add are both 

stored on a SharePoint site, a shared network drive, or a 

similar location, and if the location of the files will 

remain the same. This is handy if the linked object 

undergoes changes because the link always opens the 

most up-to-date document. 

1. Click inside the cell of the spreadsheet where you want 

to insert the object. 

2. On the Insert tab, in the Text group, click Object  . 

 
3. Click the Create from File tab. 

4. Click Browse, and then select the file you want to link. 

5. Select the Link to file check box, and click OK. 



Create a new object from inside Excel 

You can create an entirely new object based on another 

program without leaving your workbook. For example, 

if you want to add a more detailed explanation to your 

chart or table, you can create an embedded document, 

such as a Word or PowerPoint file, in Excel. You can 

either set your object to be displayed right in a 

worksheet or add an icon that opens the file. 

 

1. Click inside the cell of the spreadsheet where you want 

to insert the object. 



2. On the Insert tab, in the Text group, click Object  . 

 
3. On the Create New tab, select the type of object you want 

to insert from the list presented. If you want to insert an 

icon into the spreadsheet instead of the object itself, 

select the Display as icon check box. 

4. Click OK. Depending on the type of file you are 

inserting, either a new program window opens or an 

editing window appears within Excel. 

5. Create the new object you want to insert. 

When you’re done, if Excel opened a new program 

window in which you created the object, you can work 

directly within it. 



 

When you’re done with your work in the window, you 

can do other tasks without saving the embedded 

object. When you close the workbook your new objects 

will be saved automatically. 

C) Clip art and Text 
Ans. Clip art (also clipart, clip-art), in the graphic arts, is pre-made images used to illustrate any 

medium. Today, clip art is used extensively. Clip art comes in many forms, both electronic and 
printed. However, most clip art today is created, distributed, and used in an electronic form. Since its 
inception, clip art has evolved to include a wide variety of content, file formats, illustration styles, and 
licensing restrictions. Clip art is generally composed exclusively of illustrations (created by hand or 
by computer software), and does not include 

Text 
the main body of matter in a manuscript, book, newspaper, etc., as 
distinguished from notes, appendixes, headings, illustrations, etc. 

the original words of an author or speaker, as opposed to a translation, 
paraphrase, commentary, or the like: the actual wording of anything written or 
printed: 

D) Slide show effects 

Ans. Slide Effect is a presentation tool providing enhanced 

transitions and effects. Using a standard Presentation 
Software user interface, people can create slide presentation with 
movies and images in a simpler way than using a video editing 
software. 


